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Foreword 
  

 
 
I would like to personally welcome you to the world of open-
architecture Open Database Connectivity (ODBC) access to 
DataEase. As a loyal DataEase user, you have long impressed 
yourself by using DataEase to rapidly develop fully functional 
database applications with a minimum of fuss or technical 
programming knowledge. Quite simply, in terms of being able to 
move rapidly from ‘concept to implementation’ with an 
application, there is still nothing more effective on the market than 
DataEase. 
 
As I am sure you know all too well, the world has moved far 
beyond DOS. It is simply unacceptable now to platform new 
systems in the text-oriented style of DataEase for DOS. As 
superior as DataEase remains - even when compared to the latest 
tools - in yielding fast-track transactional systems, any technology 
must address the demands of the marketplace. The mindset has 
shifted and the world has openly embraced Windows as the 
desktop platform of choice and simply won’t accept text-based 
applications, no matter what advantages they may offer. That is 
reality. 
 
This has left you with few options. The DataEase relational data 
schema has, until now, been a closely held secret, which meant 
that DataEase data remained inaccessible, except through batch 
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exports and imports, to mainstream Windows software such as 
Microsoft Access or Crystal Reports. All the while, you have 
likely been in a quandary; faced with massive legacy applications 
that worked well, but needed to make an appearance in Windows 
to be sellable. Until now, you had one painful option: A lengthy 
and expensive total redevelopment of your applications.  
 
This was the impetus that prompted us to develop ConnectEase, 
the first ODBC driver for DataEase databases. We believe 
ConnectEase represents a watershed development for you, the 
loyal DataEase developer. Now, for the first time, you will be able 
to incrementally migrate your existing DataEase applications to the 
Windows world. You will be able to easily deploy native Windows 
interfaces on your legacy DataEase applications using the ODBC-
compliant tools you want. Your users will no longer have to see 
the dated yellow, black and blue of DataEase. You can now 
construct graphical interfaces to your existing apps using 
Microsoft Access, Visual Basic, Delphi, Powerbuilder and any of 
dozens of other tools. Using the Gold Edition, you can achieve this 
while leaving important elements of your application executing in 
native DataEase. 
 
We truly believe that with ConnectEase a new day dawns for you, 
the loyal DataEase developer. You can now satisfy the demand for 
Windows access to your DataEase data, all while working in the 
environment that you are most comfortable. 
 
Sincerely, 
 
 
Jesse R. Brin 
President 
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Using this Manual 
  

 
 
This manual is your reference to the Lanimation Technology 
ConnectEase ODBC drivers. 
 
This manual contains the following chapters: 
 
Chapter 1, "Introduction" explains the ConnectEase driver and 
ODBC, discusses environment-specific issues and explains the 
error messages returned by the drivers. 
 
Chapter 2, "Installation" describes how to install the ConnectEase 
driver on your PC workstation.  ConnectEase must be installed on 
each PC workstation that requires access to your DataEase data 
from Windows.  This chapter also describes the ConnectEase 
registration process. 
 
Chapter 3 is “Configuring ConnectEase” which describes the steps 
necessary to configure ConnectEase to access your DataEase 
databases. 
 
Chapter 4, “Using ConnectEase”, provides systematic instructions 
on how to connect to your DataEase databases with popular 
Windows applications. 
 
Appendix 1 is “Product Support and Upgrades” which describes 
the various technical support options available to ConnectEase 
users. 
 
Appendix 2, "ODBC Initialization Files" explains the structure of 
the various initialization options defined by the ODBC 
specification. 
 
Appendix 3 is “Release Notes” which describe the differences 
between this and previous releases of ConnectEase.   
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If you are writing programs to access ODBC drivers, you should 
obtain a copy of the ODBC Programmer's Reference for the 
Microsoft Open Database Connectivity Software Development Kit, 
available from Microsoft Corporation. 
 
 
 

 

Conventions Used in this Manual 
 
 
This manual uses various conventions to aid in its readability.  The 
typography, terminology, and callouts to environment-specific 
information used are intended to make this manual easy to use, 
regardless of the operating environment you are using.  The 
following section describe these conventions. 
 

Typography 
 
This manual uses various typefaces, fonts, and characters to 
indicate certain types of information, as follows: 
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Convention Explanation 
 
italics Used to introduce new terms that you may 

not be familiar with, and occasionally for 
emphasis. 

 
bold Used to emphasize important information. 
 
UPPERCASE Indicates the name of a file.  For operating 

environments that use case-sensitive 
filenames, the correct capitalization is used 
in information specific to those 
environments. 

 
monospace Syntax examples, values that you specify, or 

results that you receive. 
 
vertical rule | Indicates an OR separator to delineate items. 
 
brackets [] Indicate optional items; for example, 

SELECT [DISTINCT].  In this example, 
DISTINCT is an optional keyword. 

 
braces {} Indicate that you must select one item.  For 

example, {yes | no}.  In this example, you 
must specify either yes or no. 

 
This manual uses the following terminology: 
 
The term ODBC.INI refers to the ODBC.INI file format as defined 
by the Microsoft ODBC specification.  The appendix, "ODBC 
Initialization Files" discusses how ODBC.INI is implemented in 
all environments. 
 
The suffix .DLL refers to a dynamic link library file. 
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Environment-Specific Information 
 
Windows.  Information specific to the Microsoft Windows 
operating environment. 
 
Windows 95/98.  Information specific to the Microsoft Windows 
95 and Windows 98 operating environments. 
 
Windows NT/2000/XP.  Information specific to the Microsoft 
Windows NT or Windows 2000 or Windows XP (Home and 
Professional Editions) operating environments. 
 
This manual uses examples that are specific to Windows XP 
Professional.  If you are using the driver on other Windows 
versions, the examples may differ slightly from those depicted 
here.   
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Introduction to ConnectEase 
 Chapter 1 

 
 
ConnectEase is a Microsoft Windows™ Open Database 
Connectivity (ODBC) Driver for DataEase™ databases.  An 
ODBC driver is the link between an ODBC-compliant Windows 
application and a database.  ODBC is a standard application 
programming interface (API) developed by Microsoft for 
accessing databases.  Derived from the call level interface (CLI) 
published by the SQL Access Group and X/Open in 1992, OBDC 
provides a common access method to a variety of databases from 
most popular Windows applications.  Examples of ODBC-
compliant Windows applications include: Microsoft Access, 
Seagate Crystal Reports, Borland Delphi, Powersoft PowerBuilder, 
Lotus 1-2-3, Microsoft Excel, Microsoft Visual Basic and Corel 
WordPerfect.  ConnectEase brings ODBC to the world of 
DataEase. 
 
ConnectEase reliably and seamlessly integrates your mission-
critical DataEase databases with Windows.  ConnectEase easily 
connects ODBC-compliant software packages to your DataEase 
database applications.  Finally, Windows applications can access 
your MS-DOS DataEase data.   
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ConnectEase Versions 
 

ConnectEase ODBC for DataEase databases is available in four 
distinct versions; which one is right for you depends upon your 
specific requirements. 
 

Demo Edition (DE) 
 
ConnectEase Demo Edition (DE) is a limited version of 
ConnectEase that permits reading and writing of data to records 
contained in a DataEase database. It is intended to demonstrate the 
features and capabilities of the product.  It locks the DataEase 
database exclusively to ensure data integrity, so it is not suitable in 
a multi-user environment. The Demo Edition will only retrieve the 
first 100 records from a DataEase table. 
 

Consultant’s Edition (CE) 
 
ConnectEase Consultant’s Edition (CE) permits read and write 
access to records contained in DataEase databases. There is no 
limit on the number of records returned. The Consultant’s Edition 
locks DataEase data sources exclusively, so it is unsuitable in a 
multi-user environment with other concurrent users. The 
Consultant’s Edition is intended to address the needs of 
independent consultants who find themselves called on frequently 
to work in mixed DataEase and Windows environments. 
 

Silver Edition (SE) 
 
ConnectEase Silver Edition (SE) permits read-only access of 
records from DataEase databases. The Silver Edition is suitable for 
use in Novell multi-user environments, either with other 
ConnectEase Silver or Gold users or with DataEase users. Silver 
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Edition is intended to address advanced reporting and data-
extraction requirements by making DataEase data accessible to 
programs such as Seagate Crystal Reports Pro or Microsoft Excel. 
 

Gold Edition (GE) 
 
ConnectEase Gold Edition (GE) permits reading and writing to 
records contained in DataEase databases.  ConnectEase Gold 
Edition performs record locking, so it is suitable for deployment in 
Novell multi-user environments alongside other ConnectEase 
Gold, Silver or native DataEase users. Gold Edition is intended to 
address the most demanding requirements prevalent in 
environments where DataEase serves to deploy and support 
mission-critical business applications. 
 
 

ConnectEase Features 
 
With ConnectEase you will be able to: 
 
♦ Mine DataEase data with popular Windows applications such 

as Microsoft Access, Seagate Crystal Reports and Borland 
Delphi. 

 
♦ Unify information from multiple DataEase databases, other 

ODBC-compliant data sources and client/server databases with 
a single Windows application. 

 
♦ Migrate legacy character-based DataEase applications to 

Windows incrementally as your requirements dictate. 
 
♦ Allow everyone in your organization to have access to 

DataEase data using the application they choose. 
 
♦ Protect your investment in your extensive DataEase databases. 
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ConnectEase supports Windows 95/98 and Windows NT/2000/XP  
applications.   
 
The ConnectEase drivers support DataEase version 4.53.   

System Requirements 
 
 
Windows 95/98 
 

Minimum memory: 16 MB (64 MB Recommended) 
Disk space: 2 MB 

 
Windows NT/2000/XP 
 

Minimum memory: 64 MB (128 MB Recommended) 
Disk Space: 2 MB 
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Environment-Specific Information 
 
The following section contains information specific to the various 
operating environments supported, such as filenames, initialization 
files, etc.  Information is provided for Windows 95/98 and 
Windows NT/2000/XP. 
 

For Windows 95/98 and Windows NT/2000/XP Users 
 
On Microsoft Windows 95/98 and Windows NT/2000/XP systems, 
the ConnectEase drivers are 32-bit drivers.  If you plan to access a 
DataEase database on a network, all standard network drivers must 
be loaded and properly configured to allow access to the network 
from your Windows 95/98 or Windows NT/2000/XP system. 
 
Windows 95/98/NT/2000 Registry Information 
 
The Windows 95/98/NT/2000 Registry contains information 
necessary to access ODBC data sources.  This information is 
maintained by the ODBC Administrator program which can be run 
from the Windows 95/98/NT/2000 Control Panel.   
 
Because Windows 95/98/NT/2000 can support multiple users, the 
ODBC information is stored in the registry for each user of the 
system.   
 
The format of the registry information is the same as the 
ODBC.INI file documented in an appendix to this manual. 
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Error Messages 
 
ODBC error messages may be generated by: 
 
♦ The Microsoft ODBC Driver Manager, or 
 
♦ The ConnectEase Driver 
 
Errors reported by an ODBC component have the following 
general format: 
 
[vendor] [component] message text 
 
The vendor is Lanimation for the ConnectEase Driver or Microsoft 
for the Microsoft ODBC Driver Manager.  The component refers 
to the ODBC component in which the error occurred.  The 
message text describes the error that occurred. 
 
The Microsoft ODBC Driver Manager is a Dynamic Link Library 
(DLL) that establishes connections with ODBC drivers, submits 
requests to the drivers, and returns results to applications.  An error 
that occurs in the driver manager has the general format: 
 
[Microsoft] [ODBC DLL] message text 
 
An example of this type of message would be: 
 
[Microsoft] [ODBC DLL] Driver does not support this function 
 
An error that occurs in the ConnectEase Driver has the following 
format: 
 
[LANimation] [ConnectEase ODBC Driver] message text 
 
An example message from the ConnectEase driver is: 
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[LANimation] [ConnectEase ODBC Driver] Column not 
found: Total Amount (#1021) 
 

ConnectEase Specifications 
 
Developed with the Microsoft ODBC SDK 
 
ODBC Level 1 Compliant 
 
Supports Open Standards Committee (OSC) minimum SQL syntax 
 
Provides access to DataEase database applications 
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Installing ConnectEase 
 Chapter 2 

 
 
This chapter describes how to install ConnectEase.  You must 
install the ConnectEase version specific to your operating system.  
To use ConnectEase, you must be using Windows 95/98/NT/2000.  
ConnectEase is distributed as a download package from our web 
site at www.connectease.com 
 
 

Before you Begin 
 
You must know the full path to the DataEase database that you 
wish to access. DataEase’ internal catalog of forms (AKA Tables) 
is named  
 
RDRRxAAA.DBM 
 
where ‘x’ is replaced by a single character that represents the ID of 
the database. Each DataEase database has one and only one 
RDRRxAAA.DBM file. To establish an ODBC Data Source that 
points to your DataEase application, you need to identify RDRR 
file to the ODBC setup program.  The easiest way to do this is to 
select ‘Database Maintenance’ from the main DataEase menu. 
Then choose Database Status. Select ‘Forms’ as the type of 
object for the status report. 
 

www.connectease.com
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This will produce a screen similar to the above.  
 
If you look at the first file (Users), the third column identifies the 
name of the file system file for DataEase Users form for the 
database (USERGAAA.DBM). The fifth letter of the filename 
(‘G’) is the database ID of the database. The name of the RDRR 
file in this example would be RDRRGAAA.DBM. 
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Running Setup 
 
Please Note: This section depicts a typical installation and configuration on a Windows 
XP Professional operating system. The actual screens you receive may not exactly match 
that depicted below depending upon your specific configuration, but they should be 
close. 
 
To install ConnectEase, download and unzip the install image from 
our web site into a temporary directory or onto a CD or diskette. 
After unzipping the install package, run the supplied SETUP.EXE 
program. 
 
 
While the setup program is loading you will see the following 
screen. 
 

 
When the setup program has finished loading, the following screen 
will appear. 
 

http://www.connectease.com/download
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Click on Continue to begin the installation process or click on 
Exit to terminate the program. 
 
The following message screen will appear while the setup program 
copies the ConnectEase files to your system. 
 

 
When all files have been copied, the following Data Sources 
screen will be displayed. 
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You should select the System DSN tab. 
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Click on Add to add your DataEase database to the ODBC 
configuration.  Please note, you must add a data source for each 
DataEase database that you plan to access.  See Chapter 3, 
“Configuring ConnectEase” for more information on adding data 
sources. 
 
The Create New Data Source screen will appear. 
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Click on  ConnectEase 32 ODBC Driver in the list of installed 
ODBC drivers, then click on OK. 
 
The ConnectEase ODBC Datasource Setup screen will then 
appear.  The setup screen is organized into a tabbed notebook 
dialog box with different pages accessible through tabs appearing 
across the top of the window.  To successfully setup a 
ConnectEase data source, you must at least complete the 
information requested by the Connect Info page of the setup dialog 
box. 
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This section of the setup program requires you to assign a name to 
your data source, specify the location of the DataEase database 
system catalog (the RDRR file) and the user name and password to 
be used to gain access to the database. 
 
The RDRR file contains the descriptive information needed to 
access the database forms and data.  It is always located in the 
same sub-directory as the other files comprising a database.  Its file 
name begins with RDRR and it always has a .DBM extension.  
The only variant portion of the file name is the fifth character, 
which is a unique identifier (within a sub-directory) for the 
database. 
 
The RDRR file entry must specify a valid DataEase RDRR file 
name, including a complete path and drive specification.  The 

 button appearing to the right of the entry invokes a browse 
dialog that makes locating specific RDRR files easier.   
 
If you use the browse feature, the Data Source Name entry will be 
automatically populated with the database name stored within the 
selected DataEase database. 
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You may also type the full path to your DataEase database in the 

RDRR Location field, or you may click the  button to enter 
the path with the Select RDRR File dialog shown below. 
 

 
The Select RDRR File dialog allows you to navigate the drives on 
your system to find the directory that contains your DataEase 
RDRR file. 
 
You should then enter a name for the DataEase database that you 
wish to access.  The setup program will use the name from your 
DataEase database as the default name for your data source.  This 
name should be descriptive of the data in your database.  It is often 
beneficial to include DataEase in the name to distinguish this data 
source from other ODBC data sources that are accessible on your 
computer. 
 
You should enter your DataEase user name and password in the 
Username and Password fields. The entries should be valid for 
the selected database.  If the Username or Password fields are 
left blank or are not valid, you will be required to enter a valid user 
name and password each time you use ConnectEase to attach to the 
database. 
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Click on OK when you have entered all of the required 
information. 
 
The Data Sources window will then appear with your new data 
source listed in the data sources list. 
 

 
 
Click on Close to complete the configuration. 
 
ConnectEase is now installed on your computer.  To configure 
additional DataEase databases, refer to the chapter “Configuring 
ConnectEase”.   To register ConnectEase, refer to the chapter 
“ConnectEase Product Registration”. 
 
 

DataEase Settings 
 
In databases that ConnectEase users will share with native 
DataEase users, we suggest setting the DataEase locking option: 
‘When in Record Entry, how should viewed records be 
locked?’ to Shared. You will find this setting in the Define 
Configuration record in the System Administration section of 
DataEase. 
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Registration/Activation of Demo Software 
 
ConnectEase is initially distributed as ‘trialware’. You must 
register the software with the publisher in order to obtain full 
access to its features. You must contact LANimation or your dealer 
to register the product.  The registration can also be performed 
online World Wide Web at http://www.ConnectEase.com.  
 
The demo version of ConnectEase is fully functional except for the 
following limitations: 
 

• The demo displays an ‘About’ box each time the driver is 
used. 

• The demo limits the amount of data returned from a 
DataEase table to the first 100 records 

• There are no locks either placed or respected on the data 
being manipulated through the driver. 

 
To activate the demonstration version, you must simply click the 
‘Register’ button on the ‘About’ box as shown below. Clicking 
on OK allows execution to continue as a demo version. 
 

 
 

http://www.connectease.com/
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Clicking the 'Register' button in the About box activates the 
Registration Wizard, which allows you to choose the options you 
want and provides you with the ‘secret code’ you supply to the 
Registration Wizard to unlock the specific features you desire for 
your environment. 

 

 
 

If the software has never been serialized (i.e. a download), then 
you will first be required to obtain a serial number. The serial 
number simply allows us to track the software. You are only 
required to enter a serial number once. 

PLEASE DO NOT CALL TO OBTAIN A SERIAL NUMBER. 
The phone number shown in the dialog box above is no longer 
available correct. You may obtain your serial number at the 
connectease.com web site. 

 

http://4.21.229.16/ce_reg_mgr/signup_get.asp
http://www.connectease.com/
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Following serialization, the registration process requires three 
items of information: The location of the license 'certificate' file, 
the product class to be licensed (Consultant, Silver or Gold), and 
the number of users that are to be licensed. With the consultant 
edition (single-user), the location of the license file is unimportant 
as long as it is located in a place accessible by the driver at run-
time and the number of users is, of course, one. 
 
For multi-user versions of the software, the license certificate file 
must be on a shared network drive that all ConnectEase users may 
access (Shared read-write access to this directory is required). The 
software will function with the license file on a local drive, but 
proper file and record locking will not occur and data integrity 
could be at risk! 
 
After choosing a license file location and the product options 
desired, you should click the Register button.  This activates the 
Registration Wizard, which allows you to specify the options you 
want and to register the software license.  
 
If you obtained your copy of ConnectEase electronically (e.g. from 
the Internet), you will be required to obtain a serial number.  See 
the section, “Obtaining a Serial Number”, later in this chapter for 
information on how to complete this process. 
 
The Product Registration screen will appear as follows. 
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Complete the form.  At that point, the screen shown below will 
appear which confirms the choices made and provides a 
'Installation Identification Key' value.  
 

 
 
 
It is this key value, along with the other pertinent registration 
information, that must be conveyed to your dealer or to us in order 
to complete the process. Note that the Installation Identification 
Key is static, so we can be contacted via fax or e-mail and the 
Product Activation Key (unlock code) we provide back will be 
valid the next time you run the registration process. 
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Once you have entered a valid Product Activation Key, the product 
is enabled for the level and number of users chosen. When 
installing additional workstations on a network, simply locate the 
existing certificate file on the shared drive and leave the rest of the 
information unchanged. The Registration Wizard will use the 
information contained in the existing certificate file; no other 
registration steps are necessary. 
 
If you ever want to upgrade your software to a higher level or more 
users, simply remove or rename the certificate file. This will force 
the registration process to repeat, at which time new features can 
be selected and a fresh Product Activation Key entered. 
 
Interim product updates can simply be downloaded and installed 
over the previous version without the need to re-register. 
 
Occurrences that will require re-registration are: 
 
The certificate file becomes corrupted or disappears. 

 
The certificate file is moved from its original location. 

 
The network file server serial number changes or the volume name 
of the drive where the certificate is stored changes (applies to 
Silver/Gold only). 
 
Clients that download and register electronic versions of the 
software will receive documentation kits free of charge.  
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Connecting ConnectEase to Your 
Database 
 Chapter 3 

 
 
This chapter describes how to configure ConnectEase to access a 
DataEase database. The Microsoft Open Database Connectivity 
specification requires that each ODBC data source be defined to 
the system with the ODBC Administrator program.  The 
ConnectEase setup program described in the “Installing 
ConnectEase” chapter of this manual allows you to define a 
DataEase data source during the installation process.   
 
If you need to modify the data source defined in the installation 
process or add additional DataEase databases to your 
configuration, follow the steps outlined below. 
 
Click ‘Start’ and the select ‘Control Panel’ selection on the 
Windows Start Menu. 
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This will launch this screen: 
 

 
Then select ‘Data Sources (ODBC)’ from the Administrative 
Tools console. 
 

 
All Users  
 
Double-click on the ODBC icon to start the ODBC 
Administrator 
 
The ODBC Data Source Administrator screen will appear. 
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You should select the System DSN tab. 
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Click the Add button to add another DataEase database to your 
ODBC configuration. Please note, you must add a data source for 
each DataEase database that you plan to access.  Otherwise, scroll 
through the list of User Data Sources until you find the 
DataEase database entry that you want to change.  Click on the 
entry that you want to change and then click on Configure to start 
the ConnectEase ODBC Data Source Setup utility. 
 
If you selected Add you will see the following screen, otherwise 
skip to the next step. 
 
The Create New Data Source screen will appear. 
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Click on the ConnectEase ODBC Driver entry in the driver list 
and then click the Finish button.  
 
The ConnectEase ODBC Datasource Setup screen will then 
appear.  The setup screen is organized into a tabbed notebook 
dialog box with different pages accessible through tabs appearing 
across the top of the window.  To successfully setup a 
ConnectEase data source, you must at least complete the 
information requested by the Connect Info page of the setup 
dialog box. 
 
This section of the setup program requires you to assign a name to 
your data source, specify the location of the DataEase database 
system catalog (the RDRR file) and the user name and password to 
be used to gain access to the database. 
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The RDRR file contains information needed to access the database 
forms and data.  It is always located in the same sub-directory as 
the other files comprising a database.  Its file name begins with 
RDRR and it always has a .DBM extension.  The only variant 
portion of the file name is the fifth character, which is a unique 
identifier (within a sub-directory) for the database. 
 
The RDRR file entry must specify a valid DataEase RDRR file 
name, include a complete path and drive specification.  The  
button appearing to the right of the entry invokes a browse dialog 
that makes locating specific RDRR files easier.   
 
If you use the browse feature, the Data Source Name entry will be 
automatically populated with the database name stored within the 
selected DataEase database. 
 

 
You may type the full path to your DataEase database in the 
RDRR Location field, or you may click on the  button to enter 
the path with the Select RDRR File dialog shown below.  
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The Select RDRR File dialog allows you to navigate the drives on 
your system to find the directory that contains your DataEase 
RDRR file. 
 
You should now enter a name for the DataEase database that you 
wish to access in the Datasource Name field.  The setup 
program will use the name from your DataEase database as the 
default name for your data source. This name should be descriptive 
of the data in your database.  It is often beneficial to include 
DataEase in the name to distinguish this data source from other 
ODBC data sources that are accessible from your computer. 
 
You should enter your DataEase user name and password in the 
Username and Password fields. The entries should be valid for 
the selected database.  If the Username or Password fields are 
left blank or are not valid, you will be required to enter a valid user 
name and password each time you use the data source to attach to 
the database. 
 
The Options tab allows you to specify character translations for 
field names in your DataEase databases.  Some special characters 
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and international characters allowed by DataEase are not 
acceptable to certain Windows applications.  For example, 
Microsoft Access does not allow the following characters in field 
names: exclamation point, period, left bracket [, right bracket ], 
and back quote `. 
 
The following example shows a character translation of ‘!‘ to ‘#’,  
‘.’ to ‘_’ and ‘+’ to ‘_’.  This will cause a field named 
‘!Amount.Total’ to be displayed by the Windows application as 
‘#Amount_Total’. 
 

 
If you click on the About tab the following ConnectEase 
information screen will be displayed. 
 



  
 
 

 
 
 ConnectEase ♦ 33 

 
Click on OK when you have entered all of the required 
information. 
 
The Data Sources window will then appear with your new data 
source listed in the data sources list. 
 

 
 
Click on Close to complete the configuration. 
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Connecting Applications to Your 
Data with ConnectEase 
 Chapter 4 

 
 
This chapter describes how to access a DataEase database from 
within selected Windows applications. Since ODBC is a universal 
protocol and the numbers and types of specific ODBC-enabled 
application software packages is virtually limitless, it would be 
impossible for us to cover connection steps for every specific 
application on the market. We have chosen to outline steps for 
using ConnectEase with some of the more popular packages. Even 
if your package is not one of those listed, the steps for using 
ConnectEase with it should be similar to those shown in this 
section.  
 
For specific information on connecting your package to ODBC 
data sources, ALWAYS rely first on the instructions provided with 
your specific application by the manufacturer 
 
Connection examples are included for the following applications: 
 
♦ Microsoft Access 
♦ Seagate Crystal Reports 
♦ Borland Delphi 
♦ Powersoft Powerbuilder 
♦ Microsoft Visual Basic 
♦ Microsoft Excel 
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Using Microsoft Access 
 
 
The following example shows how to use Microsoft Access to 
connect to a DataEase database. 
 
Open Microsoft Access as you would normally. 
 
Select your Microsoft Access Database. 
 
From the Microsoft Access File menu, choose the Link Tables 
sub-menu from the Get External Data menu.  See the example 
pictured below. 
 

 
The Link screen will appear as shown below.   
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In the Files of type selection box, select files of type: ODBC 
Databases. 
 

 
Click on the Link button.  The Select Data Source window 
appears. 
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Click on the Machine Data Source tab and a list of data sources 
will be displayed.  From the list of Machine Data Sources, select 
the DataEase data source that you want to access.  You defined the 
Data Source when you first installed ConnectEase or by using the 
ODBC Administrator program described in the “Configuring 
ConnectEase” chapter of this manual.   
 
After you make your selection, click on OK.  The Link Tables 
screen will appear as shown below. 
 
From the list of tables, click on the table or tables you wish to 
access. 
 

 
After you have made your selection, click the Save password 
check box and then click the OK button.  The following screen 
should appear with your tables added to the list.   
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From the supplied list, open your selected table as you would any 
other Microsoft Access table. 
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Your data should appear similar to above example. 
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Using Seagate Crystal Reports  
 
The following example shows how to use Seagate Crystal Reports 
to connect to a DataEase database. 
 
Open Crystal Reports as you would normally. 
 
From the Report Gallery, click on SQL/ODBC icon.  
 

 
The Log On Server screen will appear. 
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Click on the ODBC Data Source for your DataEase database and 
then click on OK.  The Choose SQL Table window appears. 
 

 
Under SQL Tables, click on the table or tables from the database 
that you wish to access and click the OK button.  The Insert 
fields window will appear as shown below. 
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Click on the fields from the table that you want and then click the 
Insert button. 
 
Finally, click on the lightning bolt to execute the design.  You 
should get a Crystal report that looks similar to the following. 
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Using Powersoft Powerbuilder  
 
 
The following example shows how to use Powersoft Powerbuilder 
to connect to a DataEase database. 
 
Open Powerbuilder as you would normally. 
 
From the Powerbuilder toolbar, select the Database icon. 
 
From the main menu, pull down the File menu selections.  From 
the File menu, select Connect.  Another selection list appears.  
Click on Setup. 

 
 
A dialog box, entitled Database Profiles will appear. 
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In the Database Profiles dialog box, click on the New button. 
 
The Database Profiles Setup dialog box appears. 
 

 
 
In the Database Profiles Setup dialog, type the appropriate 
information into the blank fields.  The Database Name must 
contain a complete path and filename to your DataEase RDRR file. 
 
When you have completed the data, click on More.  An additional 
dialog box, entitled CONNECT OPTIONS, appears.  See below. 
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Type “DelimitIdentifier=’Yes’” into the DBPARM field, then 
click on OK. 
 
The Select Data Source window appears. 
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Select the Machine Data Source option.  Scroll down to and 
select the DataEase data source you want.  Then click on OK. 
 
The Database Profiles dialog box appears. 
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Click the OK button. 
 
If there are no errors, then you have created a new database profile.  
Click OK to leave the Database Profiles dialog box.  
Powerbuilder will open your DataEase database as shown below. 
 

 
 
Scroll down to a table that you wish to access and click on Open.  
The following will appear. 
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Position the cursor over the highlighted table and use the right 
mouse button to display a pop-up menu. 
 

 



Using ConnectEase 
 
 

 
 
50 ♦ lanimation technology 

From the pop-up menu, select Edit Data.  A grid view of the data 
in the table is displayed as in the example below. 
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Using Microsoft Visual Basic  
 
 
The following example shows how to use Microsoft Visual Basic 
to connect to a DataEase database. 
 
Open Microsoft Visual Basic as you would normally. 
 

  
 
Select the Visual Data Manager choice from the Add-Ins 
menu.   
 
The VisData window will open. 
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Select the ODBC choice from the Open Database sub-menu of 
the File menu.  The ODBC Login screen will appear. 
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Scroll down to your DataEase data source and double-click on it to 
select it.  The screen will reappear with connection values as 
shown above. 
 

 
Click on OK to open the data source.  The VisData screen will 
reappear with a list of available tables. 
 

 
Click on the tool bar item “Use DBGrid Control on New Form”.  
Then double-click on a table to open it.  The table will be opened 
in grid format as shown below. 
 
 
You have now successfully connected to your data. 
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Using Microsoft Excel  
 
 
The following example shows how to use Microsoft Excel to 
connect to a DataEase database. 
 
Open Microsoft Excel as you would normally. 
 
From the Excel main menu, pull down the Data menu selection.  
Select Get External Data from the Data menu selection.  
Another menu selection box appears.  Select Create New Query. 
 
 
 
The Choose Data Source dialog box appears. 
 

 
 
Click on New Data Source and then click the OK button. 
 
The Create New Data Source dialog box appears. 
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Type in the name for your new data source in field 1.  Then, from 
the offered list, click on ConnectEase ODBC Driver. 
 
 
Click on Connect.  The following Database dialog box will 
appear. 
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Type in the requested parameters.  When done, click on OK.  The 
Login to Database dialog box will appear next. 
 

 
 
Fill in the User Name and Password fields, then click on OK. 
 
The Create New Data Source window appears.  Double-click 
on the table that you want to access.   
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The Create New Data Source window changes to appear as the 
follows. 
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Select OK.  The Choose Data Source window appears. 
 

 
In the Choose Data Source selection window, click on the data 
source you just created. Press OK. 
 
The Query Wizard - Choose Columns window appears. 
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Double-click on the table that you want to access to open the list of 
available fields.  Click on the fields that you want to select and 
then click on the ">" button to add the columns to the query. Then 
click the Next button. 
 
The Query Wizard - Filter Data window will open. 
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In this example, no filtering is necessary, so click on the Next 
button again.  The Query Wizard - Sort Order window will 
appear. 
 

 
No sorting is necessary in our example, so click on the Next 
button again.  The Query Wizard - Finish will appear. 
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In the Query Wizard - Finish dialog box, click the Finish 
button to return to MS Excel.  You will be returned to Excel to a 
place where the queried data is displayed.  See below. 
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Product Support and Upgrades 
 Appendix 1 

 
 
ConnectEase is a complete and powerful ODBC driver for 
DataEase databases.  Lanimation Technology, Inc. is proud of the 
quality of the product and has spent a great deal of time and effort 
to make it easy to install and use.  If, however, you are unable to 
make the product work to your satisfaction, or, if you encounter a 
problem while using ConnectEase, the following support 
alternatives are available for you. 
 

Before You Contact Technical Support 
 
Before you contact technical support, make sure you do the 
following: 
 
♦ check the manual 
 
♦ check the README.TXT file on the installation diskette 
 
♦ check our Internet Web site  (http://www.ConnectEase.com) 
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PLEASE HAVE THE FOLLOWING INFORMATION 
AVAILABLE: 
 
♦ serial number 
 
♦ product version number 
 
♦ operating system you are using (e.g. Window 95) 
 
♦ version of DataEase that you are using (e.g. 4.53) 
 
♦ network information (e.g. Novell  4.1), if you are accessing a 

database on the network 
 
♦ contents of your AUTOEXEC.BAT and CONFIG.SYS files 
 
♦ a list of steps necessary to recreate the problem 
 

Dealer Support 
 
Lanimation Technology’s dealer network is your first line of 
support for the product.  Your dealer has been given extensive 
training on the product, has direct access to the development staff 
and should be able to provide you with immediate answers to your 
questions. 
 

Internet Support 
 
The latest information about ConnectEase is available to you 24-
hours a day, seven-days a week on our Internet Web site.  Product 
technical bulletins, tips, fixes, upgrades and other information is 
provided.  You may also post a question or a problem report for 
our technical support staff.  As soon as a technical support 
representative has had a chance to review your question or 
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problem, one of our technical support representatives will respond 
to you by return e-mail.   
 
Our Internet Web address is: 
 
http://www.ConnectEase.com 
 

Product Return Policy 
 
If you are not satisfied with ConnectEase for any reason, you can 
return it to the original place of purchase for a refund within 30 
days of the purchase date. 
 
 

Product Replacement Policy 
 
If the ConnectEase media or documentation is defective, then 
please contact Lanimation Technology, Inc. within 30 days of the 
purchase date.  You may then return the defective product to 
Lanimation Technology, Inc. for an immediate replacement. 
 
Technical Support Line (214) 324-4778. 
 

http://www.connectease.com/
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ODBC Initialization Files  
 Appendix 2 

 
 
The Open Database Connectivity specification requires certain 
configuration and connection information in order to access a data 
source.  This information is stored in an ODBC Initialization file.  
This initialization information is normally maintained by the 
ODBC Administrator program in the Windows Control Panel.  See 
the chapter “Configuring ConnectEase” for information on how to 
use the ODBC Administrator program. 
 
The format and structure of this initialization information is the 
same as defined by the Microsoft ODBC specification.  This 
appendix describes the format of this data. 
 

Environment-Specific Information 
Windows 95/98 and Windows NT/2000/XP 

 
The ODBC initialization information is stored in the system 
registry.  The system registry is a database of information about 
your system and is updated by Windows and application programs.  
The ODBC information is normally maintained by the ODBC 
Administrator, however, it is possible to view or change the 
information with a registry editor, such as the REGEDIT.EXE 
program located in the Windows directory.  
 
The ODBC initialization information is stored as a subkey of the 
key HKEY_CURRENT_USER.  The hierarchy is 
HKEY_CURRENT_USER, Software, ODBC, ODBC.INI.   
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Each user has a distinct version of the HKEY_CURRENT_USER 
database, stored under a unique user key in the registry.  Therefore, 
each user must run the ODBC Administrator to initialize and 
configure data sources in the registry.   
 

ODBC Initialization Format 
 
An INI file contains a [section] heading that is followed by 
optional attribute= value pairs, called entries.  Both the 
section name and the attributes are case insensitive.  Under 
Windows, comment lines begin with a semicolon (;). 
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The ODBC.INI format, as specified by the Microsoft Open 
Database Connectivity (ODBC) specification, is as follows: 
 
[ODBC Data Sources] 
source1=driver_desc1 
source2=driver_desc2 
. . . 
 
[source1] 
Driver=path/dll 
Description=description 
. . . 
 
[source2] 
Driver=path/dll 
Description=description 
. . . 
 
Comments are not allowed. 
 
The [ODBC Data Sources] section is mandatory.  It provides 
the driver manager with a list of data sources that are supported for 
your connection requests.  You can change the names in this list, 
but each entry must match its corresponding [ds_name] section 
in ODBC.INI. 
 
The [ds_name] sections contain a Driver= specification, 
which points to the location of the installed driver, as well as a 
Description= specification that describes the driver.  If you 
change the location of a driver, you can change the Driver= 
specification to match the new location.  You can also use just the 
name of the driver, and the driver manager will attempt to locate 
the driver based on information obtained from your environment. 
 
You might need to assign other entries depending on the data 
source you are configuring.  The section "Using a Connection 
String" in the “Configuring ConnectEase” chapter lists the 
attributes that you can set. You should use the ODBC 
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Administrator program to modify ODBC.INI. This protects the file 
from becoming corrupted or nonfunctional. 
 
 

ODBC.INI Example 
 
The following example shows an ODBC.INI file as defined by the 
ODBC specification: 
 
;---------------------------------------------------- 
; WARNING:  Do not make changes to this file without  
;           using the ODBC Control panel device or  
;           other utilities provided for maintaining  
;           data sources. 
; 
;           Incorrect changes to this file could  
;           prevent ODBC from operating or operating  
;           correctly. 
;---------------------------------------------------- 
 
[ODBC Data Sources] 
DataEase Database=ConnectEase 16/1 ODBC Driver  
Powersoft Demo DB V5 IM=Sybase SQL Anywhere 5.0 
 
[DataEase Database] 
Driver=C:\WINDOWS\SYSTEM\ceodbc16.dll 
DBQ=N:\DATA\PWRTOOLS\RDRRNAAA.DBM 
UID=jj 
 
[Powersoft Demo DB V5 IM] 
Start=c:\winapps\SQLANY50\Win\dbeng50w.exe -d -c512 
Driver=c:\winapps\SQLANY50\Win\WOD50W.DLL 
PWD=sql 
UID=dba 
DatabaseName=PSDEMODB 
DatabaseFile=c:\pwrs\Pb5\Ex\Code\PSDEMODB.DB 
 

Release Notes  
 Appendix 3 
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Please see http://www.connectease.com/releasenotes for the latest 
notes. 
 

http://www.connectease.com/releasenotes
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